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© Cypress Semiconductor Corporation, 2018-2019. This document is the property of Cypress Semiconductor Corporation
and its subsidiaries ("Cypress"). This document, including any software or firmware included or referenced in this document
("Software"), is owned by Cypress under the intellectual property laws and treaties of the United States and other countries
worldwide. Cypress reserves all rights under such laws and treaties and does not, except as specifically stated in this para-
graph, grant any license under its patents, copyrights, trademarks, or other intellectual property rights. If the Software is not
accompanied by a license agreement and you do not otherwise have a written agreement with Cypress governing the use of
the Software, then Cypress hereby grants you a personal, non-exclusive, nontransferable license (without the right to subli-
cense) (1) under its copyright rights in the Software (a) for Software provided in source code form, to modify and reproduce
the Software solely for use with Cypress hardware products, only internally within your organization, and (b) to distribute the
Software in binary code form externally to end users (either directly or indirectly through resellers and distributors), solely for
use on Cypress hardware product units, and (2) under those claims of Cypress's patents that are infringed by the Software
(as provided by Cypress, unmodified) to make, use, distribute, and import the Software solely for use with Cypress hardware
products. Any other use, reproduction, modification, translation, or compilation of the Software is prohibited.

TO THE EXTENT PERMITTED BY APPLICABLE LAW, CYPRESS MAKES NO WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, WITH REGARD TO THIS DOCUMENT OR ANY SOFTWARE OR ACCOMPANYING HARDWARE, INCLUDING,
BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PUR-
POSE. No computing device can be absolutely secure. Therefore, despite security measures implemented in Cypress hard-
ware or software products, Cypress shall have no liability arising out of any security breach, such as unauthorized access to
or use of a Cypress product. CYPRESS DOES NOT REPRESENT, WARRANT, OR GUARANTEE THAT CYPRESS PROD-
UCTS, OR SYSTEMS CREATED USING CYPRESS PRODUCTS, WILL BE FREE FROM CORRUPTION, ATTACK,
VIRUSES, INTERFERENCE, HACKING, DATA LOSS OR THEFT, OR OTHER SECURITY INTRUSION (collectively, "Secu-
rity Breach"). Cypress disclaims any liability relating to any Security Breach, and you shall and hereby do release Cypress
from any claim, damage, or other liability arising from any Security Breach. In addition, the products described in these mate-
rials may contain design defects or errors known as errata which may cause the product to deviate from published specifica-
tions. To the extent permitted by applicable law, Cypress reserves the right to make changes to this document without further
notice. Cypress does not assume any liability arising out of the application or use of any product or circuit described in this
document. Any information provided in this document, including any sample design information or programming code, is pro-
vided only for reference purposes. It is the responsibility of the user of this document to properly design, program, and test
the functionality and safety of any application made of this information and any resulting product. "High-Risk Device" means
any device or system whose failure could cause personal injury, death, or property damage. Examples of High-Risk Devices
are weapons, nuclear installations, surgical implants, and other medical devices. "Critical Component" means any component
of a High-Risk Device whose failure to perform can be reasonably expected to cause, directly or indirectly, the failure of the
High-Risk Device, or to affect its safety or effectiveness. Cypress is not liable, in whole or in part, and you shall and hereby do
release Cypress from any claim, damage, or other liability arising from any use of a Cypress product as a Critical Component
in a High-Risk Device. You shall indemnify and hold Cypress, its directors, officers, employees, agents, affiliates, distributors,
and assigns harmless from and against all claims, costs, damages, and expenses, arising out of any claim, including claims
for product liability, personal injury or death, or property damage arising from any use of a Cypress product as a Critical Com-
ponent in a High-Risk Device. Cypress products are not intended or authorized for use as a Critical Component in any High-
Risk Device except to the limited extent that (i) Cypress's published data sheet for the product explicitly states Cypress has
qualified the product for use in a specific High-Risk Device, or (ii) Cypress has given you advance written authorization to use
the product as a Critical Component in the specific High-Risk Device and you have signed a separate indemnification agree-
ment.

Cypress, the Cypress logo, Spansion, the Spansion logo, and combinations thereof, WICED, PSoC, CapSense, EZ-USB, F-
RAM, and Traveo are trademarks or registered trademarks of Cypress in the United States and other countries. For a more
complete list of Cypress trademarks, visit cypress.com. Other names and brands may be claimed as property of their respec-
tive owners.
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The CY8CKIT-005 MiniProg4 Program and Debug Kit is intended for use as a development platform
for hardware or software in a laboratory environment. In a domestic environment, this product may
cause radio interference. In such cases, you may be required to take adequate preventive
measures. In addition, this board should not be used near any medical equipment or RF devices.

Attaching additional wiring to this product or modifying the product operation from the factory default
may affect its performance and cause interference with other apparatus in the immediate vicinity. If
such interference is detected, suitable mitigating measures should be taken.

The CY8CKIT-005 MiniProg4 Program and Debug Kit, as shipped from the factory, has been verified
to meet with the requirements of CE as a Class A product.

4

A
Azl

The CY8CKIT-005 MiniProg4 Program and Debug Kits are sensitive to
electrostatic discharge (ESD). Electrostatic charges accumulate on the
human body and on other equipment. Devices that are subjected to high-
energy discharges can suffer permanent damage. Proper ESD
precautions are recommended to prevent loss of functionality. Store
unused CYB8CKIT-005 MiniProg4d Program and Debug Kits in the
protective shipping package.

End-of-Life/Product Recycling

ﬁ The end-of life for this kit is five years from the date of manufacture mentioned as bar
code on the back of the box. Contact your nearest recycler for discarding the kit.

General Safety Instructions

ESD Protection

ESD can damage boards and associated components. Cypress recommends that you work on the
board at an ESD workstation, if available. Otherwise, use appropriate ESD protection, such as an
antistatic wrist strap attached to a ground, when handling parts.
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The MiniProg4 Program and Debug Kit is an all-in-one programmer and debugger for PSoC 4,
PSoC 5LP, and PSoC 6 MCU devices. MiniProg4 also provides USB-I2C, USB-SPI and USB-UART
bridging functionality. The MiniProg4 provides a special feature enabling users to write their own
custom firmware through the custom application mode.

Figure 1-1. MiniProg4
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1.1 Kit Contents

The CY8CKIT-005 PSoC® MiniProg4 Program and Debug Kit includes:
= MiniProg4 programmer/debugger

= 10-pin ribbon cable

s USB Type-A to Type-C Cable

»  Quick Start Guide

1.2 Programming and Debugging

The MiniProg4 programmer/debugger provides the flexibility to work with SWD programming and
debugging interfaces. MiniProg4 supports 32-bit Arm® Cortex®-M0/M0+/M3/M4 PSoC devices.

The MiniProg4 debugger is supported by the software tools PSoC Creator, ModusToolbox™,
Cypress Programmer, and PSoC Programmer.

1.3 Bridging

MiniProg4 supports USB-I2C, USB-UART and USB-SPI as standard bridging protocols for any
device. The MiniProg4 bridging capabilities are used by PSoC Creator, ModusToolbox, Cypress
Programmer, PSoC Programmer, Bridge Control Panel, and other applications. Tuning software
tools such as the CapSense Tuner provided by Cypress also use these capabilities.
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1.4 Documentation Conventions
Table 1-1. Document Conventions for User Guides
Convention Usage
Courier New Displays flle_locatlons, user-entered text, and source code:
C\...cd\icc\
ltalics Displays file names and reference documentation:
Read about the sourcefile.hex file in the PSoC Designer User Guide.
Displays keyboard commands in procedures:
[Bracketed, Bold] [Enter] or [Ctr]] [C]
. Represents menu paths:
File > Open File > Open > New Project
Bold Displays commands, menu paths, and icon hames in procedures:
Click the File menu, and then click Open.
. Displays an equation:
Times New Roman 242—4
Text in gray boxes Describes cautions or unique functionality of the product.
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This chapter shows how to install MiniProg4 and its associated PC software.

21 MiniProg4
Figure 2-1. Top View
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Bridge connector Target Power LED
- Mode Select 'il;afv%:: ;
o
=" 2
Mode 24

w.s CYPRESS -
USB Type-C Error [~ — 6 5-pin SWD
connector ]

connector

MiniProg4

Programmer /| Debugger

Status

N o

Custom App

Status LED Error LED Custom App button 10-pin SWD/JTAG header

Figure 2-2. Bottom View
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2.2 MiniProg4 Installation

The MiniProg4 programmer/debugger is supported by PSoC Programmer, ModusToolbox, Cypress
Programmer, and PSoC Creator. Other software, such as Bridge Control Panel, use the PSoC
Programmer COM layer to support MiniProg4 functionality.

Note: PSoC Programmer is compatible only with the Windows Operating System however, Cypress
Programmer is compatible with Windows, macOS, and Linux. To understand the differences
between PSoC Programmer and Cypress Programmer, please see the Cypress Programming
Solutions page at http://www.cypress.com/products/psoc-programming-solutions.

1. Download and install PSoC Programmer or Cypress Programmer. Follow the on-screen
instructions to install the software.

Each programming tool supports a subset of Cypress devices. See respective tool
documentation for which device each supports.

2. Launch PSoC Programmer or Cypress Programmer and connect the MiniProg4 to your
computer’s USB port using the provided USB cable. When properly connected, and drivers have
been installed, the Mode LED either turns ON or will be ramping (slowly increasing and
decreasing brightness) depending on the mode.

Note that the MiniProg4 drivers are automatically installed.

3. In PSoC Programmer, to connect to the port, in the Port Selection pane, click the MiniProg4
device. You can also click Connect/Disconnect button as shown in Figure 2-3.

If the connection is successful, a status indicator in the lower-right corner of the PSoC
Programmer window turns green and shows “Connected”.

You can now use MiniProg4 to program the target device by clicking the Program button.

Figure 2-3. PSoC Programmer: MiniProg4 Connect/Disconnect and Program

Program Connect/Disconnect

B PsoC Prdgrammer - m] X

File  VieWl Options Help

Wil EH-DDB

| Por Setection Programmer  Utiliies  JTAG
12 MiniProg4 (CMSIS-DAP/BULK/130F085303147 | - Programming Parameters Memory Types
File Path: C:\Userslsaga\Desktop\MP4_DFTlInfo\Hex Files\kitprog3 hex Load from hex Load from device
- ..[2] Main Flash [64K]
Programmer; MiniProg4 (CMSIS-DAP/BULK/180F085303147400)
Programming Mode: @) Reset (' Power Cycle Power Detect
< 5 | Verification: ®on O of Connector; 5p (&) 10p
AutoDetecti 6
Device Famiy utoDetection ®on O of Clock Speed: | 1.6 MHz
CYBCScaxl P Programmer Characteristics Status
Protocol: JTAG ® SWD |1SSP 12C Execution Time: 0.6 seconds glzi[bdy;es)'
Device Power Status: OM art address:
Voltage:
AT Votage: O 5.0v @ 33v O25v O18v | -2 3238 My End address:

Actions Results

Power On at 11:15:12 AM MiniProg4 (CMSIS-DAP/BULK/190F085303147400)

Successfully Connecte... MiniProgd4. CMSIS-DAP Version 2.0.0. Firmware Version 1.01.122. Hardware Id 0S5.
Cpening Port at 11:15...

Connected at 11:15:03 AM MiniProg4 (CMSIS-DAP/BULK/190F085303147400)

For Help, press F1

For more information on how to use PSoC Programmer, see Help Topics under the Help menu
in PSoC Programmer or press [F1].
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In Cypress Programmer, to connect to the MiniProg4 probe, click Connect/Disconnect button as
shown in Figure 2-4.

If the connection is successful, a status indicator in the lower-right corner of the Cypress
Programmer window turns green and shows “Connected”.

You can now use MiniProg4 to program the target device by clicking the Program button.

Figure 2-4. Cypress Programmer: MiniProg4 Connect/Disconnect and Program

File View Options Help

=) | O 2
L Probe: MF4 BULK-1C100BFB00125400 ~ Architecture: PSoC@ ~ % _«; @ @ (é) &3
Open Fower || Disconnect | Erase §Programl Read Verify
Settings x

Program Settings

File C:/Users/srds/Documents/ModusToolbox/CE224717DataLogger_mainapp/Debug/CE224717Datalogger_mainapp.hex
Reset Chip
Probe Settings
Interface SWD
Voltage (V) 33
Reset Type Soft

External Memory
Program Securit...

Log

Info : cyp_get_mpn i)
Info : tcl server disabled

Info : Listening on port 4445 for telnet connections

Info : Open On-Chip Debugger

Info : init_target

Info : Only resetting the Cortex-M core, use a reset-init event handler to reset any peripherals or configure hardware srst
support.
Info : kitprog3: acquiring PSoC device...

Info : target halted due to debug-request, current mode: Thread

Info : xPSR: 0x01000000 pc: 0xB0001f34 msp: Ox080477a8

Info : ** Device acquired successfully

Info : ** Detected device PN: CY8C6347BZI-BLD53 SiliconID: E207 Revision: 0@ FamilyID: 100

»

Info : ** 5Flash 5iliconID: OxE2872200
Info : ** Flash Boot version: 8x822A3801
Info : ** psocb.cpu.cmd: Ran after reset and before halt...

Info : target halted due to debug-request, current mode: Thread

Info : xPSR: Ox61000000 pc: 0x16004008c msp: 60000000

Info : cyp_get mpn

Info : ** Detected device PN: CYBC6347BZI-BLD53 SiliconID: E207 Revision: 00 FamilyID: 100

Info : true v

Connected to the programming device m Connected

For more information on how to use Cypress Programmer, see View Help under the Help menu
in Cypress Programmer or press [F1].
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23

MiniProg4 LEDs

Installing MiniProg4

MiniProg4 has three indicator LEDs - Mode (Amber), Status (Green), and Error (Red) as shown in

Figure 2-5. Table 2-1 indicates the behavior of these LEDs for various operations.

Figure 2-5. MiniProg4 LEDs

Mode LED

- Mode Select

Mode

Error

Status

-

& CYPRESS

MiniProg

Programmer / Debugger

o o saN

4

1

-
N o

Custom App

Status LED Error LED

Table 2-1. LED representation for various operations of MiniProg4

Programming Mode

Programming Status

Three LEDs

Mode Indicator

Status Indicator 1

Status Indicator 2

(Amber LED) (Green LED) (Red LED)

Programming 8 Hz OFF

Success ON OFF
CMSIS-DAP HID Ramping (1 Hz)

Error OFF ON

Idle OFF OFF

Programming 8 Hz OFF

Success ON OFF
CMSIS-DAP Bulk ON

Error OFF ON

Idle OFF OFF
Bootloader N/A 1Hz OFF OFF
Custom Application | N/A 8 Hz ON ON

CY8CKIT-005 MiniProg4 Program and Debug Kit Guide, Doc. # 002-19782 Rev. *B
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Installing MiniProg4

24 MiniProg4 Buttons

MiniProg4 has two buttons that enable switching between various operating modes. Figure 2-6

shows the location of the buttons. In order to understand switching MiniProg4 modes, refer to
Figure 2-7.

On power-up, MiniProg4 is in CMSIS-DAP/BULK Mode by default. If the Mode Select button is
pressed, MiniProg4 enters CMSIS-DAP/HID mode. If the Custom App button is pressed, MiniProg4
enters custom application mode where a user can run their own custom applications on the MCU
contained in the MiniProg4. See Figure 2-7 for details.

For details of LED indications of various modes of MiniProg4, refer to Table 2-1.
Figure 2-6. MiniProg4 Buttons

Mode Select
button

————
- Mode Select

woss G CYPRESS

Error

-

MiniProg4

1
Programmer / Debugger

[=]

Status

—
Y]

Custom App

Custom App button

Figure 2-7. Various MiniProg4 Button Modes

Mode button
is pressed
while plugging
in USB
connector

Mode button
pressed

Custom A
Firmware i

Upgrade
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MiniProg4 is a protocol translation device. With MiniProg4, the PC host software can communicate
through a USB port to the target device to be programmed or debugged, as shown in Figure 3-1.

lists the protocols that are supported by each connector.

MiniProg4 enables

Table 3-1
communication with the target devices using 1/O voltage levels from 1.5V to 5 V.
Figure 3-1. System Block Diagram
PC
USB Cable —»
MiniProg4
10-pin Ribbon  swp 12-pin
Cablelor 5-pin e/ Communication
Direct vesr Header
Connection
Target Board

Table 3-1. Connectors / Communication Protocol Support

(S Al I%c Sl Wit?\ﬁl?tTF(IY)vvi: IE:irr‘nilrol)
5-pin Supported N/A N/A N/A
10-pin Supported N/A N/A N/A
6x2 header |N/A Supported Supported Supported

CY8CKIT-005 MiniProg4 Program and Debug Kit Guide, Doc. # 002-19782 Rev. *B
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Interfaces

SWD

ARM-based devices support the Serial Wire Debug (SWD) protocol. The PSoC 4, PSoC 5LP, and
PSoC 6 MCU device families implement this standard, which offers programming and debugging
functions. MiniProg4 supports programming and debugging of PSoC 4, PSoC 5LP, and PSoC 6
devices using SWD through the 5-pin or 10-pin connector.

Before programming a PSoC 4, PSoC 5LP, or PSoC 6 MCU device, make sure you review the
electrical connection requirements in the respective device datasheet or in the PSoC 4, PSoC 5LP,
and PSoC 6 MCU device programming specifications. You can find the datasheets and
programming specifications here:

www.cypress.com/PSoC4
www.cypress.com/PSoC5LP
www.cypress.com/PSoC6

12C

I°C is a common serial interface standard. It is mainly used for communication between
microcontrollers and other ICs on the same board but can also be used for intersystem
communications. MiniProg4 uses an I°C multimaster host controller that allows the tool to exchange
data with 1°C-enabled devices on the target board. For example, this feature may be used to tune
CapSense® designs.

MiniProg4 serves as a USB-I°C bridge (acts as 1°C Master) that can be used to communicate with a
I°C slave devices through the Bridge Control Panel software. For I°C connections use the 6x2
connector. MiniProg4 has internal pull-up resistors and supports 1°C speed up to 1 MHz.

SPI

The Serial Peripheral Interface (SPI) is a synchronous serial communication interface specification
used for short distance communication, primarily in embedded systems. SPI devices communicate
in full duplex mode using a master-slave architecture with a single master.

MiniProg4 serves as a USB-SPI bridge (acts as SPI Master) that can be used to communicate with a
SPI slave devices through the Bridge Control Panel software. For SPI connections use the 6x2
connector. MiniProg4 supports SPI speed up to 6 MHz.

UART with and without Flow Control

UART is another common serial interface standard. MiniProg4 supports UART, which allows the tool
to receive data from UART enabled devices on the target board. MiniProg4 provides UART
communication both with and without hardware flow control. In order to enable flow control, RTS and
CTS pins are provided in the 6x2 I/O header. If flow control is not required, CTS and RTS pins can
be left floating. Terminal emulators such as Tera Term or PuTTY can be used to communicate with
the target PSoC device. MiniProg4 supports UART speed up to 115200 Baud Rate.

Reference

For more information on the PSoC 4, PSoC 5LP, and PSoC 6 MCU's JTAG, SWD, and 12C
interfaces, see the PSoC 4, PSoC 5LP, and PSoC 6 Technical Reference Manuals.

For more details on how to use MiniProg4 with Bridge Control Panel, refer to the Bridge Control
Panel Help document.

CY8CKIT-005 MiniProg4 Program and Debug Kit Guide, Doc. # 002-19782 Rev. *B 13
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3.2 Connectors

3.21 5-Pin Connector

The 5-pin connector is configured as a single row with a 100-mil pitch. Suggested mating connector
part number is Molex Connector Corporation 22-23-2051.

Figure 3-2. 5-Pin Connector with Pin Assignments

® SDAT
® solK
() XRES
(] GND

o VTARG

MiniProg4 Mating
(End View) Connector

Note: If the design requires MiniProg4 to be directly plugged to the target board with a 5-pin header,
adequate mechanical clearance shall be provided near the 5-pin header on the target board. The
width & height of MiniProg4 (5-pin header area) is 25mm x 13mm. If the design cannot meet the
required mechanical clearance, use a stackable header (such as Proto-PIC 20690).

322 10-Pin Connector

The 10-pin connector is configured as a dual row with 50-mil pitch. It is used with a ribbon cable
(provided) to mate to a similar connector on the target board. The signal assignment is shown in
Figure 3-3. Suggested mating connector part number is CNC Tech 3220-10-0300-00 or Samtec Inc.
FTSH-105-01-F-DV-K-TR.

Figure 3-3. 10-Pin Connector with Pin Assignments

———  Note The ribbon
XRES cable connector
‘ extends beyond the
GND body of the
DI connector. Be sure
|| to allow room.
GND
TDO / SWO
GND |
TCK / SWCLK
GND
TMS / SWDIO
VTARG
Pin 1
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Technical Description

Here is a summary of the protocols and related pin assignments. The pin mapping is also shown on

the back of the MiniProg4 case.
Table 3-2. Communication Protocol Pin Assignments

Protocol Signal 5-Pin 10-Pin
SDIO 5 2
SWD SCK 4 4
XRES 3 10

323 6x2 Connector

This connector supports all the communication protocols like 12C, SPI, UART (with or without flow

control supported by MiniProg4). Figure 3-4 shows the pin assignments. They are also shown on the
back of the MiniProg4 case.

Figure 3-4. 6x2 Connector Pin Assignments

SDA

SCL

TX
RX

RTS

GND
12
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3.3 Power
MiniProg4 can be powered using the USB interface.

On kits/boards where there is a single power supply for the entire board, MiniProg4 can supply
power to the board. However, this supply is limited to approximately 200 mA, and is protected
against excess current draw. You can select 1.8 V, 2.5V, 3.3V, or 5V from PSoC Programmer or
Cypress Programmer. The 5 V supply may vary between 4.25 V-5.5 V, because it is supplied
directly from the USB port. The maximum deviation for other voltages is +5%.

Note: Some PSoC device families do not support 5 V operation. Refer to the respective device
datasheet for supported voltage selection.

Voltage stress beyond acceptable limits can permanently damage
MiniProg4. Programming signals can withstand over-voltage up to
maximum 12 V and minimum up to —=5 V. Communication bridge signals
(I12C, UART & SPI) can withstand over-voltage only up to maximum 6 V
and minimum up to -1 V.
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A1 Regulatory Compliance Information

The CY8KCIT-005 MiniProg4 Program and Debug Kit complies with the CE-Low Voltage Directive
2006/95/EC (Europe) safety requirement. It has been tested and verified to comply with the following
electromagnetic compatibility (EMC) regulations.

CISPR 22 - Emissions

EN 55022 Class A - Immunity (Europe)
CE - EMC Directive 2004/108/EC

CE Declaration of Conformity
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Document Title: CY8CKIT-005 MiniProg4 Program and Debug Kit Guide
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